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Massachusetts Base Station Information 
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Name Frequency Bit Rate
Acushet, MA 306 200 

Hudson Fall, NY 324 200 
Moriches, NY 293 100 

Portsmouth Harbor, NH 288 100 
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General Description of the Garmin GPSMap76 
 

 
 
 
 
 
 
 
 
 
 
                  Rocker 
 
 
Button Descriptions: 
 
Power Key: The Power key is used to turn the unit on and off.  Press and hold the Power 

key to turn off the GPS. 
Rocker Key: The Rocker key is used to control the movement of the cursor on menus 

and map displays (up, down, left, right). 
Page Key: The Page key is used to navigate through the 5 main display pages.  The 

Page key will also end an operation in progress and return to one of the main 
pages. 

Quit Key: The Quit key is also used to navigate through the 5 main display pages in the 
opposite direction of the Page key and quit out of a menu or selection.  

Menu Key: The Menu key will display the page options menu for the current page.  
Pressing the Menu key twice will display the main menu. 

Enter Key: The Enter key is used to activate a data field or make a menu selection.  
Pressing and holding the Enter key will allow the user to capture the current 
position as a waypoint. 

Zoom In and Zoom Out Keys : Allow you to zoom in and out on the map page to show 
more or less detail. 

Nav Key:    The Nav key is used to navigate to locations saved in the Garmin unit. 
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Main Screen Descriptions 
• There are five (5) main pages on the Garmin unit. 

• The Satellite Page 
• The Map Page 
• The Pointer Page 
• The Highway Page 
• The Active Route Page 
 

These pages are arranged sequentially on the unit, like on a rolodex.  The Page and Quit 
keys are used to navigate between the pages. For example, if you are viewing the Satellite 
Page and you want to see the Highway Page, you can get there by pressing the Page key 
three times or the Quit key twice. 
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Unit Check Before Leaving the Office  
 
• Before leaving the office it is important to make sure the GPS unit is working. This will 
save time and frustration because a problem can be found/fixed at the office before you 
travel to your field site 
• Turn on the handheld unit and connect differential receiver to make sure they work 
• Check to see the memory is cleared of waypoints/tracks 
• Ensure that the batteries are charged 
 
 
In the Field (Point Collection Setup) 
 
• Connect the battery pack to the differential receiver in the backpack 
• Connect the gray wires from the backpack into the handheld unit 
• Set the unit to receive a differential signal (RTCM in/NMEA out) 

• From the Main Menu highlight Setup and press the Enter 
button 

 • Scroll (left/right) to the Interface tab  
 • Highlight the Serial Data Format (Ex. Garmin) 
  
 
 
 
 
 
 
 
 
 
 
 
• Press the Enter button 
 • Scroll down to highlight RTCM In/NMEA Out 
 • Press the Enter button 

• Scroll down to highlight the Beacon field and press the Enter 
button 

 • Scroll to highlight User and press the Enter button  
• Enter the Frequency and Bit Rate for the appropriate base station 

 • Highlight the Freq field and press the Enter button 
• Scroll through the numbers to select the correct 
frequency information. Press the Enter button 

• Scroll right to the Bit Rate field and press the Enter button 
• Scroll down to select the correct bit rate and press the Enter button 
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• Frequency and bit rate information can be obtained from the Base Station 
Information section of this manual.  

 
 • Check to see the unit is receiving a DGPS (differentially corrected) signal 

• Press the Quit button to return to the Satellite page 
• A “D” will appear at the bottom of the satellite strength indicator bar  
• The Receiver Status Message will say 3D Differential  

 
 
 
 
 
 
 
 
 
 
 
  
 
 
Waypoint Collection 
 
Hint: Good field notes will help ensure that you do not forget what or where your points 
are. You may take a lot of points in one day and may not remember everything when you 
return to the office. Keeping a record of starting and stopping point numbers will be 
critical when you manipulate your data.   
The location of a waypoint is taken from the antenna on the backpack not the handheld 
unit; be aware of this when marking waypoints. Remember to check your accuracy 
periodically; it will fluctuate during point collection. 
 
• Mark a waypoint  

• Press and hold the Enter button for 2 seconds until the Mark 
Waypoint page appears  

• The Mark Waypoint page displays information about the waypoint 
that was taken. It shows the number of the point, the date and time, and 
the location of the point 
• To confirm the information, press the Enter button with the OK tab 
highlighted 
• Marking your starting point in the field with a flag or using a 
reference location is a good way to make sure that you do not overlap 
when taking points. This will make the process of converting points to 
polygons easier and more accurate 
 
 

Satellite Strength 
Indicator Bars 

Receiver Status 
Message 



 

GPS Field Guide  page 7

Adjacent Fields 
 
• Adjacent fields/strips must have their points collected in a specific way, so when 
polygons are made for each strip/field the acreage is correctly calculated  
• The diagram below is an example of how points should be collected 
• A coincident boundary should never have points taken on it twice 
• A point must be collected at every corner of each strip/field 
 

 
 
Note: It is important to keep a good field record of your point numbers so you don’t 
forget what you did when you get back to the office. The starting and ending point 
numbers should be noted for each field/strip. Be aware that GPS points are connected 
by a straight line, when marking curved features points must be taken close together 
in order to properly and accurately display the curved area. 
 
Waypoint Averaging  
 
If additional accuracy is needed when collecting waypoints or collection conditions are 
less than ideal, the averaging function may be useful. Averaging works by taking several 
points at one location and creating an average location from all points taken, resulting in 
one waypoint marked for that location. This helps to make the location more accurate.  
Do Not move while using the averaging function, this will lead to poor accuracy.  
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• After holding the Enter button for 2 seconds the Mark Waypoint page appears 
• Press the Menu button  
• Highlight Average Location and press the Enter button  
 
 
 
 
 
 
 
 
 
 
 
 
• The Average Location screen appear 
• The measurement count is taking a point every second 
• To stop taking averaging points press the Enter button with the Save box highlighted 
 
 
 
 
 
 
 
 
 
 
 
 
 
• This returns you back to the Mark Waypoint screen  
• You proceed as if you had just taken a single waypoint  
 

 
Navigation Back  
  
The Garmin unit not only allows for the collection of data, but can also 
be used as a navigational tool. These units allow users to “Navigate 
Back” to a location that contains geo-referenced data. This function is 
useful when trying to locate a point that was previously taken with the 
unit, or navigating to points that were planned in the office. In order to 
navigate back to a point you must first have point data loaded in the 
Garmin unit. Instructions for this can be found in the Uploading Points 
section of this manual. 
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The “nav back” feature of the unit is an interface using the pointer page and the highway 
page. The pointer page will give you a visual display showing which direction to walk, 
and the distance to the point. The highway page is used as you get close to your location 
and displays a left or right offset for added precision.  
 
Warning: Learning how to manipulate the navigation screens will take some practice. It 
is important that you practice and become proficient at using the interface before 
attempting to locate points for a field application. 
 
• At your field location, set the unit to receive a differential signal 
• Press the NAV button once on the handheld unit 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• In the window that appears, confirm that Go To Point is highlighted and press the 
Enter button 
• In the Points box that appears, confirm that Waypoint is highlighted and press the 
Enter button 
• A list of waypoints you have loaded in the unit will appear, press the Enter button, use 
the rocker key to highlight the point you wish to navigate to and press the Enter button 
• The Waypoint page appears; with Goto highlighted, press the Enter button 
• Use the Page button to move to the Pointer Page  
• The Pointer Page shows the direction and distance you need to travel to the point 
 
 

 
 

Distance to point 

Directional arrow 

Vertical line 
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• To navigate to the point, you must turn so the directional arrow points to the vertical 
line. When you are facing directly toward your destination, the directional arrow will be 
pointed toward the top of the display, aligned with the vertical line 
• If you are no longer heading toward your destination, the directional arrow will turn 
away from the vertical line to point toward your destination (illustrated above) 
• To head in the proper direction again, turn until the directional arrow realigns with the 
vertical line 
• The distance to point box displays the distance you have until you reach your 
destination  
• As you get close to your destination the directional arrow will become less useful due 
to the proximity of the destination point to your current location. To make navigation 
more effective and accurate, the Highway Page and Pointer Page should be used together. 
• The Highway Page will allow for smaller scale adjustments as you near your 
destination. 

 

 
 
 
 
• As you near your destination you will hear two beeps informing you that you are 
getting close. A message will be displayed at the bottom of the unit. Press the Enter 
button to clear this message 
• The highway page displays the distance to your destination and displays an offset that 
will show the distance you are off left or right of the exact location. If an L appears in the 
offset box that means that you are offset left and need to move right. If an R appears you 
are offset right and need to move left 
• When the distance to point box and the offset both read 0.00 you have reached your 
destination  
 
Note: Remember that there is always a small amount of error associated with all GPS. 
Attempting to get 0.00 in both boxes may in some cases be impossible. As a rule of 
thumb, acceptable error is L/R <0.5 ft in the offset box, and <1.0 ft in the distance to 
point box. 
 
 
 
 
 
 

Distance to point 

Offset 
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Measuring in the Field 
 
The GPS units are capable of doing “in the field” linear measuring. The GPS unit will 
allow you to take measurements that were previously measured using the wheel. A good 
example of this is a riparian buffer situation. Here you can use the GPS to mark the 
stream bank with several points, then measure 180 feet out from those points. This allows 
you to get an exact location of the stream bank, place stakes at 180 feet, and record the 
location of those stakes for your plan all in one trip to the field. 
 
• Set up the Garmin unit to receive a differential signal 
• Locate the point from where you want to measure  
• Take a point  
• Move to the Pointer Page or the Highway Page using the Page button 
• Select a reference point, and begin walking 
• The distance will be displayed  
 
 
 
 
 
 
 
 
 
 
• When you reach the distance you want to measure, place a flag and mark the point 
• This feature can also be used for measuring existing features, instead of measuring a set  
distance you can measure the distance between two existing features. 
  
Tracks 
 
Tracking is another method of using the GPS to collect data. Tracks work in a similar 
manner to waypoints, but in tracking mode the GPS unit automatically takes points at 
preset distance or time intervals. When the unit is tracking it is collecting a series of 
waypoints that are stored together in a track log. This differs from individual waypoints. 
A single waypoint is stored as a single unit and can be manipulated as such, whereas 
points taken in tracking mode are stored together in a track log file and do not 
contain the same characteristics or attribute data that individual waypoints do.  
 
Tracks are complicated and are recommended only for expert users. The Garmin unit 
contains an active log that tracks every location the unit has been. When using the 
tracking feature, you are selecting out certain parts of this active log and saving them. 
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The problem with tracking lies in the fact that points are taken continuously, so if you 
stop to tie your shoe or talk to the landowner you are still collecting points. This can lead 
to inaccurate data. Tracking should only be used in certain situations and is not 
designed for all uses. Before using tracking, make sure it is the best method for 
getting the job done.   
 
Setting the Collection Method for Tracks 
 
There are three options for collecting data using the tracking function. These are distance, 
time, or auto. The distance setting will take a point after a specified distance has been 
traveled. The time setting will record a point after a specified amount of time has passed. 
The auto setting uses terms such as “more often” and “less often,” but does not give a 
specific value for when data will be collected. The collection mode should be set 
according to the task you are working on. The collection mode must be set before you 
begin tracking. 
 
• From the Main Menu, highlight Tracks and press the Enter button 
• The Tracts screen appears 
• Press the Menu button 
• Highlight Setup Track Log and press the Enter button 
• The Track Log Setup Window appears 
• Highlight the selection under Record Method 
• Press the Enter button  
• Select Distance, Time, or Auto (time is the recommended method) 
• Highlight your selection and press the Enter button 
• Using the rocker key, highlight the selection under Interval and pressing the Enter 
button will allow you to change the interval of point collection. This is done using the 
rocker key to change the values of the highlighted selection. Press the Enter button to 
accept changes (Time is displayed in hh:mm:ss) 
• Highlight the selection under Recording and press the Enter button 
• Here you have the choice of Off, Wrap When Full and Stop When Full 
• You will only use Stop When Full or the Off selection 
• Highlight Stop When Full and press the Enter button 
• Highlight OK at the bottom of the screen with the rocker key and press the Enter button 
• The unit is now ready to start tracking 
 
Collecting Tracks 
 
• Check to see the unit is receiving a differential signal 
• Locate the point where you want to start tracking 
• From the Main Menu choose Tracks and press the Enter button 
• The Tracts screen appears 
• In the Tracks screen use the rocker key to highlight CLEAR 
• Press the Enter button 
• You are asked if you really want to clear the track log 



 

GPS Field Guide  page 13

• Highlight Yes and press the Enter button 
• The log is now clear and you may begin walking the area where you want to collect 
points 
 
Note: You must clear the track log immediately before collecting data. If you clear 
the log, but do not start walking immediately, you must clear the log again before you 
start collecting data.  
 
• When you have reached the end of the area you are tracking, you must stop the track 
log 
• This is done in the Track Log Setup screen 
• Highlight Stop When Full under Recording and press the Enter button 
• Select Off and press the Enter button 
• Highlight OK and press the Enter button 
 
You have now turned off the track log; the unit is no longer collecting data for the track 
log. If you have more areas to track, you need to follow the previous instructions (p.20-21). 
This will allow you to collect track data for several sites without having to return to the 
office after each field location. If you are doing multiple tracks during a field visit, DO 
NOT clear the track log after you have collected track data. You WILL erase the data 
that was previously collected. 
 
• After you have collected all track data for the day you need to save the track log  

• From the Tracks page, highlight Save, and press the Enter button 
• The Save Back Through window appears, highlight Entire Log and press the 
Enter button       
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ArcView and DNR Garmin 
 
Office Planning 
 
Using some advanced features in ArcView and the DNR Garmin software it is possible to 
take advantage of the GPS system from the office. This is especially helpful when 
planning occurs in areas with little or no spatial reference points to take measurements 
from. Using the DNR Garmin software ArcView allows you to locate points in the office 
and then navigate back to those points on the earth. This process is similar to uploading 
existing GPS data, but it uses data that you create. 
 
• Open ArcView 
• Add data in ArcView that you want to work with. This may be an ArcView project in a 
customer folder, or a newly created ArcView project. 
• Create a new point theme using the Toolkit button, in a customer or View and select 
New Theme.  
 
• Using a theme such as an aerial photograph or topo map place the points in the 
locations where you want to navigate back to 
• After you have placed all the points you must edit the table to give each point a number 

• Open the table for the point theme you just created, from the Table menu select 
Start Editing 

 • Using the table Edit tool give each point a number in the ID field starting with 1   
 
 
 
• Use the Edit tool to choose the cell you wish to edit and enter the 
numbers in sequential order 

• After all the points are given an ID, from the Table menu, select Stop Editing 
and save edits   

 
 
 
 
 
 
 
 
 
 
 
 
• Using the same steps discussed in the Uploading Points section, select all points to be 
uploaded to the Garmin unit  
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• Upload the points 
• In the DNR Garmin window from the Waypoint menu select Upload 
• A window appears telling you the transfer is completed and the number of waypoints 
that were uploaded to the unit 
 
Remember: When creating new themes they must be saved in the correct location with a 
proper name. Keeping the default is not acceptable. If you are creating something 
permanent it should be saved in that customers file with a meaningful name. If you are 
experimenting or creating temporary files these, should be removed when you are 
finished with them. 
 
Downloading Waypoints (Office Mode) 
 
• Attach the black 4 pin cable to the COM port on your computer and into the back of the 
handheld unit 
• Turn on the unit and start simulator mode 
 • From the Satellite page press the Menu button 

• See that Start Simulator is highlighted and press the Enter button 
• The Receiver Status Message will say Simulating GPS 

 
 
 
 
 
 
 
 
 
 
 
 
• From the Main Menu highlight Setup and press the Enter button 
• Change the Serial Data Format from RTCM In/NMEA Out to 
GARMIN 
• Scroll to the Interface tab 
 • Highlight the Serial Data Format  
 • Press the Enter button 
 • Scroll to highlight GARMIN 
 • Press the Enter button 
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• Start ArcView 
• Open an existing project, or open the template 

• Check to see if the DNR Garmin menu appears 
 

 
 
• If it does not, in ArcView turn on the DNR-Garmin-ArcView extension  
 • From File choose Extensions (only if DNR Garmin is not it the Menu bar) 
 • Scroll down to DNR Garmin – ArcView and check the box, click OK 
 
• From the Menu bar click on DNR Garmin 
 
Setting the Projection 
 
• Select Set Projection – if the box does not display UTM-1983 and your correct 
county zone (ie 18 or 19) you will have to change it 

 
Note: If this is the first time the DNR Garmin extension is used you WILL have to 
change the projection.  

 
• If the information in the Use Default Projection box is correct click Yes  
• If the information is incorrect click No, to change it 

 

 
• The Projection Properties box appears 
• Click the arrow next to Category and select UTM-1983 
• Click the arrow next to Type and select your Zone (18 or 19)  

 • Click OK 
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• Click on the DNR Garmin menu, then click on Open Garmin GPS 

 
 

 
• A new MN DNR Garmin window will appear. In the bottom left hand corner you will 
see the unit connecting 
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Downloading Points 
 
• In the MN DNR Garmin window, click Waypoint and choose Download 

• You will see the points downloading in the MN DNR window and will hear two 
beeps from the handheld unit when the download is complete 

• In the MN DNR Garmin window, click File, choose Save As and click on ArcView 
Shapefile 

  
• A save as box appears 
• Navigate to F:\geodata\gps_data  

• Save your points using the naming convention 
  • <subject>_xd_ma countyFips code_yearmonthday 
  • The subject will be the collector’s name 

• xd will be used if the points are differentially corrected 
  • x will be used if the points are not differentially corrected 

• Example: KParons_xd_ma015_20020712 
• Click OK 

  
• The shapefile appears in the table of contents 
• Click to put a checkmark in the box next to the theme to make it appear in your view 
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Make a polygon from GPS Points  
 
The DNR Garmin extension allows users to create polygons from points collected with the 
Garmin unit. The software will connect the centers of each point creating an accurate 
polygon. Remember that your end results are only as good as the initial GPS data you collect. 
 
• Make the GPS point theme active 
• Using the select feature tool, select the points you want to use to make a polygon 

• Holding down the Shift key will allow you to select multiple feature 
 • Points may also be selected using the GPS point theme table 
 
• From the Menu bar click on DNR Garmin and select Convert Points 

• A Convert Points window will appear 
• In the Point Theme select your GPS point theme 
• From the Order Field select Ident 
• From Conversion Type choose To Polygon 
• From Output select As Shapefile 
• Click GO 

 
 
 
 
 
 
 
 
 
 
• Navigate to the GPS folder 
• Name and save the file in the GPS folder under the Soils 

• It is important that you name your shapefile a meaningful name so you know 
what the shapefile is. Do Not keep the default name of Polygon 1.shp 

 
 
 
 
 
 
 
 
 
 
 
 
• Your new theme appears in the table of contents of ArcView 
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Making a Point or Line Shapefile  
 
In addition to creating polygons from GPS points, the DNR Garmin extension also allows 
you to create point or line features (shapefiles). This is helpful for marking an individual 
location such as a well or a grain bin or marking a linear feature such as a fence. 
 
Making a Line 
 
• This is done just like creating a polygon. Instead of selecting multiple points and 
making a polygon, multiple points are selected to make a line 
• Select the points needed to create the line  
• Click on the DNR Garmin menu and select Convert Points 
• In the Convert Points window that appears select: 
 • Point theme: The theme that contains the GPS points 
 • Order Field: Ident 
 • Conversion Type: To Line 

• Output: As Shapefile 
• Click GO 

• Name and save the file to the correct location 
• The new line theme now appears in your table of contents in ArcView 
 
Creating a Point(s) 
  
• Creating a point theme is a good way to show individual feature(s) such as a well or 
grain bin that do not have a linear component or for which a polygon is not appropriate 
• Using the select feature button, select the point(s) that you want to make a new theme 
• In ArcView click on the Theme menu and select Convert to Shapefile 

• Name the file and save it in the proper location 
• Click OK  
• Question: Add shapefile as theme to the view?  
• Click Yes 
• The new theme now appears in your table of contents 

Selected Points
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After Download 
 
After you are done downloading GPS points, make sure that the unit is ready for the next 
user. 
 
• Ensure that you have unplugged the battery pack from the differential receiver 
• Recharge the battery pack  
• Clear the memory on the handheld unit 
 • From the Main Menu choose Points and press the Enter button 
 • In the Points window choose Waypoints and press the Enter button 
 • The Waypoint by Name screen appears with a list of points,  

• Press the Menu button 
 • Scroll to Delete All and press the Enter button 

• Question: Do you really want to delete all waypoints? 
 • Highlight Yes and press the Enter button 
 
 
 
 
 
 
 
 
  
  
 
 
Uploading Points 
 
In addition to downloading points, the DNR Garmin software allows users to upload 
previously saved GPS point data to the GPS unit. This is useful when trying to find a 
location that had been previously GPS-ed, or to locate points in the field that were 
planned in the office. 
 
• Start ArcView (it is not necessary to be in a customer file) 
• Add the GPS point theme from F:\geodata\gps_data  
• From the DNR Garmin menu select Open Garmin GPS  
• Using the select feature tool in ArcView, or selecting from the table, select all the 
points to be uploaded to the unit 
• In the DNR Garmin window, from the File menu select Load, WayPoints From, then 
select ArcView Theme 
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• The Export Waypoints from Shape dialog box appears asking for an identity input 
• Select Ident from the list and click OK 
 

 
 

• The Export Waypoints from Shape dialog box appears again 
• Click the Cancel button 
 

 
 

• In the DNR Garmin window from the Waypoint menu select Upload 
• A window appears telling you the transfer is completed and the number of waypoints 
that were uploaded to the unit 
 
 
 
 
 
 
• The points are now saved back to the Garmin unit 
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Downloading Tracks 
 
After you have collected track data, it can be downloaded and accessed in ArcView in 
three ways: a polygon, a line, or points. 
 
• Prepare the handheld unit for downloading 
• Start ArcView and open the DNR Garmin window 
• In the DNR Garmin window from the Track menu select Download 
• After the download is complete click on the Advanced button 
 

 
 
• The DNR Garmin window expands showing information about the track points 
• Under the ident field you will see Active Log. The records containing Active log are the 
only records we want to keep. All records that do not contain Active Log must be deleted 
• Every time a new track was started it appears in blue  
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• In order to select one track from the rest of the tracks in the unit, the other track points 
need to be deleted 
• In the example on the previous page and below, we only want to keep rows 1 through 8, 
which is the first track 
• Using the pointer hold down the shift key and select all points you do not want, by 
clicking on the row number. The rows will highlight in dark blue 
 

 
 
• With the unwanted points highlighted click the delete button 
 
  
 
 
• This will leave you with the track points associated with one track 
• In the DNR Garmin window from the File menu select Save as, then ArcView 
Shapefile 
 
• An Output Shape dialog box appears and asks you to define the output shape as a 
polygon, a line, or the track points 
 

 
 
• Select the output you want and click OK 
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• If you have existing data in your view of the same feature type, you will be asked if you 
want to create a new shapefile or append to an existing one 
• In most cases you will select New Shapefile and click OK 
 

 
 
• Name and store your new file in the customer folder using a meaningful name NOT 
track# 
• The new shapefile appears in your table of contents 
 
• To save the second track out of the track log you must download the points again and 
delete those points that are not associated with the second track.  
 
• The entire Active Log should be saved in the same manner that GPS points are saved. 
All track points taken in one day will be saved together in one file 
• The file will be saved as points and will be named using the following naming 
convention 

• <collector’s name>_T_xd_maFips code_yearmonthday 
• Example: kparsens_T_xd_pa043_20031018 

• The only difference between naming track points and GPS points is the _T after the 
collector’s name. This differentiates between points collected using the tracking feature 
and points collected as waypoints  
• The file will be stored in the same location as all other GPS points 

• F:\geodata\project_data\nrcs\gps_data  
 
Deleting Tracks 
 
After tracks have been saved as a point file to the server they may be removed from the 
handheld unit. 
 
• From the main menu highlight tracks and press the Enter button 
• In the Tracks window that appears press the menu button 
• A window appears highlight Delete All Saved and press the Enter button 
• You are asked are you sure? 
• Highlight Yes and press the Enter button 
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Data Management 
 
Metadata 
 
For every GPS shapefile you save  create a metadata file that will accompany it.  The 
metadata file is a text file that describes the data you have created. It will contain 
information such as the date that the file was created, who created the file, datum 
information, projection information, subject, what the data really is, etc.  
• The metadata file will be created by using an extension for ArcView called Metadata 
Builder 
 
Using Metadata Builder 
 
• Check to see the Metadata menu appears in the ArcView menu bar 
• If it does not, in ArcView turn on the Metadata Builder extension  

• From the File menu choose Extensions  
• Scroll down to Metadata Builder and check the box, click OK 

• Ensure that the theme you are going to create the metadata for is the active theme  
• From the Metadata menu and select Make Metadata File 
 

 
 
• The Make Metadata File window that appears, complete all of the information boxes. In 
some data boxes you are given default choices to choose from; to choose these, click on 
the arrow on the right side of the box and click on the appropriate information 
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• After all the data boxes have been filled in, click on the Build Metadata File button in 
the bottom right hand corner. This completes the creation of the metadata file 
• The metadata file can be edited or viewed by clicking on Metadata in the menu bar and 
choosing either edit metadata file or view metadata file 
• The metadata file is a .txt file located in the same location that the original theme is 
saved. The metadata file will have the same name as the original source file with and 
additional _metadata.txt on the end 
 
Note: Sometimes you cannot view the metadata file immediately after making it. This 
can be eliminated by saving the project, then viewing the metadata. 

 
Naming and Storing Files 
Naming conventions are subject to change due to requirements of Toolkit etc. Below is a 
place to start. 
 
Correctly naming your files and storing them in the proper location will help to guarantee 
that your files are being backed up. This will help to keep data from being lost, saving 
you time and frustration in the future. Any files that you create that are permanent MUST 
be saved in the customer’s folder or the server with a meaningful name.  
• GPS point files 
 • The naming convention for these files will be:  

• <collectors name>_ma countyFips code_yearmonthday 
• Example: kparsons_ma015_2002072002 

 
• GPS track files 
• GPS points collected using the tracking feature will be saved using the same naming 
convention as regular GPS points with ONE EXCEPTION. After the collectors name a 
_T will be placed indicating that these points were collected using the tracking feature.  
 • Naming convention for track files 

• <collector’s name>_T_ma countyFips code_yearmonthday 
• Example: kparsons_T_ma043 20031018 

 
• GPS point and track files will be stored in the gps_data or the customer’s folder on the 
server 

• F:\geodata\gps_data  or the customer’ folder 
 

 
•  Shapefiles that are created from a GPS point file will be stored in the correct project 
file on the server 
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Trouble Shooting 
 
• The DNR Garmin extension will not open. Two error messages will be displayed. 
 
 
 
 
 
 
 
 
 
Possible Solutions 
• Ensure the GPS handheld unit is turned on and in simulator mode and the Serial Data 
Format is set to GARMIN 
• Check to ensure the black download cable is correctly seeded in the com-port and 
handheld unit 
• From the DNR Garmin window, under the GPS menu. select Assign Port and Select 
Port 2. (Most desktop computers will have two serial ports in the back, selecting port 2 
will tell the software to look for information from port 2 rather than port 1) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• The Garmin unit will not turn on. 
 
Possible Solutions 
• Check to see if the handheld unit contains batteries, and replace if necessary 
• Ensure that both grey cables from the differential wire bundle are correctly connected 
and inserted correctly into the back of the handheld unit 
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• The Garmin unit is not receiving a differential signal. (You will observe an 
uncharacteristically high number in the Accuracy box, the receiver status message 
will not read Differential, and/or the D’s in the signal strength bars are absent)   
 
Possible Solutions 
• Check the bit rate and frequency settings to confirm you have selected the correct base 
station for your location within the state  
• Check to see that the battery is charged and correctly seeded in the connector 
• Ensure the grey cables are correctly connected 
• Check the component cables attached to the differential receiver, making sure each is 
properly connected 
• Ensure that the differential receiver is getting power, by confirming there is text in the 
display window on the receiver 
 
Note: Some locations in the state will not be able to receive a differential signal due to 
topography or lack of sufficient signal strength from a base station. Noted areas have 
been in the Northeast, Northwest, and the Southwest corners of the state.  
 
• There is no message displayed on the differential receiver when the battery is 
plugged in. 
 
Possible Solutions 
• Recharge the battery, to ensure that the battery is not dead 
• Check wires to see that all are correctly connected 
• Check to see if indicator light on battery connection is illuminated 
 
• The indicator light is not illuminated during charging of the battery or during 
connection of the battery and the differential unit. 
 
Possible Solutions 
• Check fuse in the male adaptor in either the charging unit or the batter connector unit. 
Replace fuse if blown 
 
 
 
 
 
 
Additional assistance with any GPS questions or problems contact John Kick at the Massachusetts State Office in 
Amherst.  
Email: john.kick@ma.usda.gov  
Phone: (413) 253-4378 
 


